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Lab 1 Case study: RTL design 

 

1. Change directory to lab 1 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_1 

 

2. Let us review design first. 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_1/design 

 

3. There is a core module as shown, our goals is to 
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A. Package core module to a CHIP 

B. Use ADPLL IP to provide core clock 

i. Reference clock input: 100 MHz 

ii. ADPLL clock output: 1600 MHz 

iii. Core clock: 100 MHz 
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Input pads Output pads
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4. ADPLL SPEED_SELECT[9:0] pin configuration 

Reference clock: 100 MHz 

ADPLL clock: 1600 MHz 

 

If SPEED_SELECT[9] == 1’b0 

Then 1600 = 100 * ( 4 * SPEED_SELECT[8:0] + 4) 

Get SPEED_SELECT[8:0] = 9’d3 

 

If SPEED_SELECT[9] == 1’b1 

Then 1600 = 100 * ( 4 * SPEED_SELECT[8:0] + 2) 

Can’t get the result 

 

Now, we can configure ADPLL IP as shown: 

File name CORE.v 

Line 20 
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5. Core clock is 100MHz, but ADPLL clock output is 1600MHz, therefore, we need 

frequency divider. 

 

Because 1600MHz clock frequency too high, so we partition frequency divider 

into two parts. 

A. First, use binary counter for high speed frequency divider. 

File name div2_clk.v 

 

D Q

R

DFF

clk

reset

div2
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B. Second, use Jonson counter 

File name div8_clk.v 
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C. Finally, we can get a divide-by-16 frequency divider. 

File name CORE.v 

Line number 24 and 25 
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6. To prevent reset problems, we need reset synchronizer. 

File name sync_reset.v 

 

D Q
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DFF

D Q
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DFF
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Because the core function MUST wait the ADPLL ADPLL_LOCK pin active high, we 

need an AND gate for core reset function. 

File name CORE.v 

Line number 27 and 28 
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[Think about it] 

Why frequency divider’s reset pin use “ADPLL_reset” instead of 

“sync_core_reset”? 

 

7. Some of input/output ports are crossing two clock domains, so we need data 

synchronizers. 

Port direction Port name SRC. Clock DEST. Clock Line number 

Input X CLK clk_div16 30 

Input HALT CLK clk_div16 32 

Input DoDCT CLK clk_div16 33 

Input Mode CLK clk_div16 34 

Output Z clk_div16 CLK 40 
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Multi/single bit data synchronizer 

File name cross_sync_bit.v 

cross_sync_data.v 

 

data_outdata_in
D Q

DFF

D Q

DFF

D Q

DFF

D Q

DFF

dffa dffb1 dffb2
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[Think about it] 

Why output signal “ADPLL_LOCK” only sync with “div16_clk” clock? 
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8. Finally, put all designs together. 

File name CORE.v 

 

 

9. And then running RTL simulation. 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_1/sim_rtl 

Unix% ncverilog –f vlog.f 
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Lab 2 Case study: CDC CHECK 

 

1. Change directory to lab 2 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_2 

 

2. Open the SpyGlass in interactive mode 

Unix% spyglass 
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3. Reading design list 

 

 

 

 

4. Set read options 

 

Un-check “Show Common Option Only” 
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Setting common options 

Language Mode verilog 

Top Level Design Unit CHIP 

Others Default 
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Setting advanced options 

Enable Handle Memories Yes 

Enable Analysis of Instantiated DesignWare Components Yes 

Others Default 
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5. Run Design Read and save project “case.prj” 

 

 

 

6. Check “Msg Tree”, make sure everything is fine. 

 
 

7. Switch to “Goal Setup & Run” 
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8. Select goals 

Initial_rtl clock_reset_integrity clock_reset_integrity 

Initial_rtl cdc_verif cdc_verif_base 

Initial_rtl cdc_verif cdc_verif 

 

 

9. Highlight the goal “clock_reset_integrity” by right-click and then perform “Setup 

Goal” 
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10. Switch function tab to “Setup Goal” and run “Run Setup Wizard” 

 

 

11. Click “Next” to perform “Setup Preference”. 

 

12. Click “No” to skip advanced setup. 

Do you want to perform advanced setup? No 

 

13. Let Spyglass identify everything. 

Do you have any SGDC files? No 

Do you want to import constraints from SDC files No 

Identify potential clocks used in the design? Yes 

 

14. Click “Next” to perform “Resolve Blackboxes” 
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15. Click “Next” and show clock trees. 

Show clock trees and finalize clock definition interactively? Yes 

 

 

16. Click “Next” to verify clock setup. 

Verify clock setup? Yes 

 

 

17. Click “Next” to setup reset signals 

Edit and complete reset constraints? Yes 
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Because the signal “CHIP.Mode” and “CHIP.u_CORE.ADPLL_LOCK” act like reset 

behavior, Spyglass identifies them. In this case, we can’t need these two signals, 

so we comment them by “#”. 

 

 

Click “Next” to save file. 
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18. Because all of ADPLL data input/output can treat as false paths, except 

ADPLL_LOCK signal. But this “ADPLL_LOCK” is asynchronous signal, so we can skip 

“Set up Black Boxes in the Data Path” by clicking “Next”. 
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Also, we can skip “signal_in_domain” SGDC setting by clicking “Next”. 

 

 

 

19. Click “Yes” to edit IO domains. 

Edit and complete IO Domains Yes 
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Use “Copy all” to setting input/output “Actual Clock” 

Input HALT CHIP.CLK CHIP.CLK 

Input DoDCT CHIP.CLK CHIP.CLK 

Input X[0:11] CHIP.CLK CHIP.CLK 

Input Others NA NA 

Output Z[0:11] CHIP.CLK CHIP.CLK 

Output Sync_ADPLL_LOCK CHIP.u_CORE.ADPLL_

CLK 

CHIP.u_CORE_ADPLL_CL

K 

Output Others NA NA 
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20. Save SGDC file 

Copy content in toplevel SGDC file instead of including file link Check 

Others Default 
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21. Click “Next” to perform “Check issues with Setup for Formal Verification” 

Check setup now? Yes 

 
 

[Think about it] 

Why we can ignore all the errors? 

 

22. Click “Next” and finish setup. 
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23. Switch function tab back to “Select Goal” 

 

 

24. Right-click “Run Selected Goal(s)” to run goals sequentially. 

 

 
 

25. Switch to “Analyze Results” section 
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26. Switch goal to “initial_rtl/clock_reset_intergrity/clock_reset_integrity” and then 

check warnings and errors 

 

 
 

27. Switch goal to “initial_rtl/cdc_verif/cdc_verif_base” and then check warnings and 

errors 
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28. Switch goal to “initial_rtl/cdc_verif/cdc_verif” and then check warnings and 

errors 

 

 

 

[Think about it] 

Can we waive these errors? If not, how to fix errors? 
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Lab 3 Case study: Synthesis 

 

1. Change directory to lab 3 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_3 

 

2. Setting SDC variables 

File name CHIP_dc.tcl 

Line number 3~29 

 

3. Setting master clocks 

File name CHIP_dc.tcl 

Line number 34 and 35 
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4. Setting divide clocks 

File name CHIP_dc.tcl 

Line number 38 and 40 

 

 

[Think about it] 

Why “ADPLL_CLK_DIV8” use “edges” and “edge_shift”? 

 

5. Setting clock uncertainty 

File name CHIP_dc.tcl 

Line number 49 ~ 52 

 

 

[Think about it] 

What is “set_clock_uncertainty –from clka –to clkb] means? 

 

6. Setting clock latency 

File name CHIP_dc.tcl 

Line number 54 ~ 58 

 

 

[Think about it] 

Why we need “rise/fall” and “early/late” options? 

 

7. Setting false path 

File name CHIP_dc.tcl 

Line number 76 
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[Think about it] 

Why we can set “sync_ADPLL_LOCK” to false path? 

 

8. Setting clock transitions 

File name CHIP_dc.tcl 

Line number 80 and 81 

 

 

9. Setting ADPLL IP library 

File name .synopsys_dc_.setup 

Line number 7, 10, 11 and 21 

 

 

10. Open the design compiler in GUI mode 

Unix% dv 
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11. Reading design 

File => Read… => chip_syn.ddc 

 

 

 

12. And then you can review the design and analysis timing.  
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13. Close design compiler and open the synthesized Verilog netlist. 

File name chip_syn.v 

 

Because the post-synthesis simulation use pseudo-random jitter mode, we need 

to add a parameter in Verilog netlist file. 

Line number 7666 

 

 

[Think about it] 

Open the VCD waveform file, can you tell difference between ideal jitter mode 

and pseudo-random jitter mode? 
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Lab 4A Case study: Layout (SOC Encounter) 

 

1. Change directory to lab 4A 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_4A 

 

2. Open the SOC Encounter 

Unix% encounter 

 

3. Import Design by loading configure file 

Configure file name CHIP.conf 
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4. Because we provides a independent power domain for ADPLL IP, we needs extra 

configuration. 

 

In the “Design import” window, switch tab to “Advanced”. 

 

 

At “Power” section, add another power/ground name for ADPLL IP 

 

 

5. Click “OK” to perform design import 
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6. Global net connection. 

 

Floorplan => Connect Global Nets… 

 

 

First, connect global power net to “VDD” 

Pin name VDD 

Scope Apply All 

To Global Net VDD 
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Connect global ground net to “VSS” 

Pin name VSS 

Scope Apply All 

To Global Net VSS 

 

Connect ADPLL IP power net to “PLLVDD” 

Instance Basename u_T90_ADPLL 

Pin Name(s) VDD 

Scope Apply All 

To Global Net PLLVDD 

Override prior connection Check 

 

 

Connect ADPLL IP ground net to “PLLVSS” 

Instance Basename u_T90_ADPLL 

Pin Name(s) VSS 

Scope Apply All 

To Global Net PLLVSS 

Override prior connection Check 
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Connect ADPLL power pad to “PLLVDD” 

Instance Basename ADPLL_VDD* 

Pin Name(s) AVDD 

Scope Apply All 

To Global Net PLLVDD 

Override prior connection Check 

 
 

Connect ADPLL power pad to “PLLVSS” 

Instance Basename ADPLL_VSS* 

Pin Name(s) AVSS 

Scope Apply All 

To Global Net PLLVSS 

Override prior connection Check 

 

Apply and check global net 
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7. Floorplan 

 

Floorplan => Specify Floorplan… 

 

 

Setting design dimensions 

Ratio (H/W) 1 

Core Utilization 1 

Core to Left 50 

Core to Top 50 

Core to Right 50 

Core to Bottom 50 

 
 

[Notice] 

Do NOT use this floorplan configuration for real design! 
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8. Move ADPLL IP into floorplan as shown below 

 

 

[Think about it] 

Why we move ADPLL IP to the corner? 

 

9. Place other IPs 
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10. Create power ring. 

 

Power => Power Planning => Add Rings… 
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Basic power ring configuration 

Net(s) VSS VDD 

Top Layer M7 

Top Width 8 

Top Spacing 1.5 

Bottom Layer M7 

Bottom Width 8 

Bottom Spacing 1.5 

Left Layer M6 

Left Width 8 

Left Spacing 1.5 

Right Layer M6 

Right Width 8 

Right Spacing 1.5 

Offset Center in channel 
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Advanced power ring configuration 

Use wire group Check 

Interleaving Check 

Number of but 2 

 

 

Click “OK” to create power ring. 

 
 

[Think about it] 

Why we don’t need to create power ring for “PLLVDD/PLLVSS”? 
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11. Connect ADPLL IP to their own power/ground pads 

 

Route => Special Route… 

 
 

At Basic SRoute configuration tab 

Net(s): PLLVSS PLLVDD 

Route Pad Pins 
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At Advanced SRoute configuration tab and go to “Pad Pins” section 

Number of Connections to Multiple Geometries All 

Others Default 

 
 

Click “Apply” to perform SRoute 
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12. Connect power ring to power/ground pads 

 

At Basic SRoute configuration tab 

Net(s): VDD VSS 

Route Pad Pins 

 

13. There is nothing special after ADPLL IP placement and power planning.  
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Lab 4B Case study: Layout (IC Compiler) 

 

1. Change directory to lab 4B 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_4B 

 

2. Open the SpyGlass in GUI mode 

Unix% ic_shell -gui 

 

3. Setting library reference 

 

File => Set Technology File… 
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Setting library reference 

Library name CHIP 

Input reference libraries: ../beta_lib/tpzn90gv3 

../memory_lib/RF2SH64x16 

../adpll_lib/ADPLL_TSMC90_TinnoTek 

../designkit_lib/tpbn90gv 

../designkit_lib/tsmc090g 

../designkit_lib/tsmc090gthvt 
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4. Open design 

File => Open Design 

Library name CHIP 

Cells CHIP 

 
 

5. Move ADPLL IP to corner as shown below, and then fixed placement 
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6. Perform Global PG net connection (VDD/VSS) 

Preroute => Derive PG Connection… 

Manual connect Check 

Power net VDD 

Ground net VSS 

Power pin VDD 

Ground pin VSS 

 

 

7. Create another supply net for ADPLL IP 

icc_shell> create_supply_net PLLVDD 

icc_shell> create_supply_net PLLVSS 
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8. Perform “PVDD1ANA_33/PVSS1ANA_33” PG net connect (PLLVDD/PLLVSS) 

Preroute => Derive PG Connection… 

Manual connect Check 

Power net PLLVDD 

Ground net PLLVSS 

Power pin AVDD 

Ground pin AVSS 

 

 

9. Perform ADPLL IP PG net connect (PLLVDD/PLLVSS) 

icc_shell> derive_pg_connection -power_net PLLVDD -ground_net PLLVSS \ 

-power_pin VDD -ground_pin VSS -cells u_CORE/u_T90_ADPLL –reconnect 

  

 

  



[LAB 4B CASE STUDY: LAOUT (IC COMPILER)] 2012年 3月 16日 

 

Using PLL in Cell-Based Design / NARL CIC DSD DTS C. L. Huang Lab 4B - 6 
 

10. Create a block ring for ADPLL IP 

 

Highlighted the ADPLL IP. 

 

 

Preroute => Create Rings 
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Switch tab to “Rectangular” tab 

Nets PLLVDD PLLVSS 

Specified macros u_CORE/u_T90_ADPLL 

Left Check 

Left Offset 1 

Left Width 5 

Left Layer M4 

Right Check 

Right Offset 1 

Right Width 5 

Right Layer M4 

Top Check 

Top Offset 1 

Top Width 5 

Top Layer M5 

Bottom Check 

Bottom Offset 1 

Bottom Width 5 

Bottom Layer M5 

Others Default 

 
 



[LAB 4B CASE STUDY: LAOUT (IC COMPILER)] 2012年 3月 16日 

 

Using PLL in Cell-Based Design / NARL CIC DSD DTS C. L. Huang Lab 4B - 8 
 

11. Connect “PVDD1ANA/PVSS1ANA” pads to ADPLL block ring 

 

Preroute => Preroute Instances… 
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Preroute instances configuration 

 

At “Instances” section 

Type Pad 

All except specified instances check 

At “Primary routing layer” section 

Pin Check 
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12. Connect ADPLL PG pin to block ring 

Preroute => Preroute Instances… 

Type Macro 

Specified instance check 

 

 

 

13. Place other cells and then finish design.  
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Lab 5 (SKIP) Setup for SpyGlass Constraint File 

 

1. Change directory to lab 5 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_5 

 

2. Open the SpyGlass in interactive mode 

Unix% spyglass 
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3. Reading design list 

Function tab Add Design Files 

Source list verilogfilelist.f 

  

 

 

 

4. Switch function tab to “Set Read Options” 
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5. Setting language mode to “verilog” 

Language Mode verilog 

 
 

6. Setting top module name 

Top level Design Unit processor1 

 

 

7. Switch function tab to “Run Design Read” 

 

 

8. Saving project before read design 

File => Save Project As => lab5 => Save 
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9. Reading design 

 

 

 

10. Goal setup 
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11. Switch function tab to “Select Goal” and select CDC methodology 

Goal => initial_rtl => cdc_verif => cdc_verif_base 

 

 

 

12. Switch function tab to “Setup Goal” and run setup wizard 

 

 



[LAB 5 (SKIP) SETUP FOR SPYGLASS CONSTRAIN FILE] 2012年 3月 16日 

 

Using PLL in Cell-Based Design / NARL CIC DSD DTS C. L. Huang Lab 5 - 6 
 

 
 

13. Click “Next” and click “No” to run the basic setup. 
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14. Let SpyGlass identify everything! 

Do you have any SGDC files No 

Do you want to import constraints from SDC files? No 

Identify potential clocks used in the design? Yes 

 
 

15. Resolve blackboxes 
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16. Setting clocks 

Show clock trees and finalize clock definition interactively?  Yes 
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17. Click clock “processor1.clk1” first and then click “incremental schematic”, you can 

see simplified schematic. 
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18. Click “Next” to generate sgdc file 

 
 

19. Validate clock constraints 

Verify clock setup? Yes 
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20. You can see some information at “Message Tree” 

 

 

21. Select one of messages and click “Incremental Sch” to see simplified schematic. 
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22. Click “Next” to next setup. 

 

 

23. Reset setup 

Edit and complete reset constraints? Yes 

 

 

24. Verify reset is set correctly. 
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25. IO port and clock domain relationship setup 

Edit and complete IO domains? Yes 

 

 

26. Setting actual clock 

in2 processor1.clk2 

other input processor1.clk1 

 

Click in2 and then select processor1.clk2 

 

 

Click “Copy all” to copy all inferred clocks to actual clock 
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27. Click “Next” move to SGDC file save setting. 

Copy content in toplevel SGDC file instead of including file link Check 

Other Default 

 

 

28. Click “Close” and save project 
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Lab 6 (SKIP) Clock/Reset integrity check 

 

1. Change directory to lab 6 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_6 

 

2. Open the SpyGlass in interactive mode 

Unix% spyglass 
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3. Loading project 

Project file name Lab6.prj 

 

 

 

4. Switch function tab to “Select Goal” 
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5. Select new goal “clock_reset_integrity” 

Goal list 

clock_reset_integrity/clock_reset_integrity Check 

cdc_verif/cdc_verif_base Check 

Others uncheck 

 

 

6. Highlight the “clock_reset_integrity” goal and switch function tab to “Setup Goal” 

 

 

 

7. Run Setup Wizard for setup “clock_reset_integrity” goal 
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8. Click “Next” to next step 

 

 

9. Perform basic setup 

Do you want to perform advance setup? No 

 
 

10. Let SpyGlass identify everthing! 

Do you have any SGDC files? Yes 

Do you want to import constraints from SDC files  No 

Identify potential clocks used in the design No 
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11. Click “Next and check every SGDC file is setting correctly. 

 

 

12. Clock setup 

Show clock tree and finalize clock definition interactively? Yes 
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13. Click “Next” and perform verify clock setup. 

Verify clock setup? Yes 

 

 

 

14. Click “Next” and skip reset setup 

Edit and complete reset constraints? Skip 

 

 

15. IO port setup 

Edit and complete IO Domains? Yes 

 

Input Inferred Clock(s) Actual Clock 

In2 processor1.clk2 processor1.clk2 

Others Default Copy from inferred clocks column 
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16. Click “Next” and finish setup. 

Copy content in toplevel SGDC file instead of including file link Check 

Others Default 

 
 

17. Click “Next” and check setup 

Check setup now Yes 
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18. Click “Finish” and finish closure 

 

 
 

19. Save project 
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20. Analyze goal 

 
 

21. Click “Run goal” to run target goal 

Run Goal Initial_rtl/clock_reset_integrity/clock_reset_integrity 

 

 

22. In the “Msg Tree” tab of the message window, group messages by “goal” 

 
 

23. Expand the “clock_reset”integrity” goal folder and then expand the 

“Reset_check04” rule folder. 
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24. Double-click the “WARNING” message. The “Help” window tells us the reset 

signals that are used asynchronously as well as synchronously for different 

flip-flops. 

 

 

25. Invoke incremental schematic by pressing hotkey <i> and you will see 2 flip-flop 

fed by reset signal in different modes. 

 

 

[Tips] 

If it warning message is being don intentionally in design then it’s OK and a 

waiver should be added for this violation, else, it is recommended to decide on a 

uniform reset strategy and stick to it. 
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Lab 7 (SKIP) Performing metastability checks 

 

1. Change directory to lab 7 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_7 

 

2. Open the SpyGlass in interactive mode 

Unix% spyglass 

 
 

3. Open project 

Project file name Lab7.prj 
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4. Switch run goal to “verif_base/cdc_verif_base” 

 
 

5. In the message tree view, double-click the ERROR folder. 

 
 

6. Select the “Ac_unsync01” message and right-click. In the context window, select 

the “Open Spreadsheet…” option. And then, you will see the spreadsheet viewer. 
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[Tips] 

Click any column will sort that column, for example you may like to sort source or 

destination in a real design scenario. 

 

7. Since hierarchical signal names are often longer and may not be visible in 

spreadsheet cell, default the name are LEFT justified, but you can change it. 

View => Configure Column Text Alignment” 
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8. Let’s scroll over to the left of the viewer, in the first column, there is an ID field, 

click the first entry in this field. Notice that the corresponding message in the 

message tree view of the CONSOLE as well as the line of code in the RTL view is 

being high-lighted. 
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9. You can use spreadsheet viewer to interactively to apply cdc_false_path on a 

crossing 

 

Click the cell to select the particular path 

SOUCE Processor1.InFast 

 

 

Click the “C” button to set cdc_false_path 

 

 

Select “Source FF, Dest FF” and click “OK” 
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cdc_false_path will be generated in constraints editor 
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Finally click “Append & Run” to update the constraints file and run the analysis. 

 

 

 

 

[Tips] 

If you have more paths to be set cdc_false_path on, repeat the above steps. 

 

10. Open the “Ac_unsync02” rule folder. 
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 [Think about it] 

What’s the “Ac_unsync02” rule? 

 

11. Right-click on “Ac_unsync02” folder and select “Open Spreadsheet” 
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12. In the “DEST” column locate “top.processor1.inst_p.rx_data2_q[3:0]” and click on 

“ID” to open violation spreadsheet and at the same time it will also cross-probe 

to Msg tree. 

DEST. top.processor1.inst_p.rx_data2_q[3:0] 

 

 

 

13. At the spreadsheet viewer “ac_unsync04.asv (ReadOnly), click “incremental Sch” 

icon to debug. 
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[Think about it] 

The failure reason it seems that MUX inputs are fed by asynchronous source. But 

why “rx_data2_q” is reported as unsynchronized? 

(HINT: Double clock the MUX input!) 

 

[Tips] 

SpyGlass, by default, reports all such crossing as unsynchronized/metastable. 

Apply a “cdc_false_path” constraint on paths that are having exception such as 

static or test or debug logic. 

 

14. In the spreadsheet for “Ac_unsync02” rule violation locate destination 

“top.processor1.inst_p.rx_data3_q[3:0]” in “DEST” column 

 

 

15. Click on the “ID” field and you will see this will cross probe the violation in 

schematic/Msg Tree, also a violation spreadsheet will open. 
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16. As you can see above reason of failure is “No valid synchronizer” used, which 

means tool is unable to find any synchronizer or synchronized control line. Also 

tool is also showing a potential qualifier for this crossing. 

 

 

17. Locate the “Potential Qualifier” at “Type” column and click on the “ID” field to 

cross-probe to schematic and open “Incremental Sch” window. 
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[Think about it] 

From the schematic it seems qualifier is a double flip-flop synchronized signal and 

gating the source on AND gate. There is potential qualifier shown for “rx_data3”. 

If as a designer you accept this potential qualifier then what is the risk you are 

taking? 

(HINT: Trace fan-in of OR gate which comes in between crossing, no asynchronous 

source should feed into OR gate other input) 

 

18. Close all the spreadsheet viewer and incremental schematic windows. 

 

19. To check the reset synchronization, double-click the “Reset_sync01” rule folder 

(under the Warning folder). You will see violation reported for the reset signal 

“rst”. 

 

 

[Tips] 

The rule “Reset_sync01” checks an asynchronous reset, should be synchronously 

de-asserted, relative to the clock. If an asynchronous reset is NOT synchronously 

de-asserted, the it may cause the following problems: 

 Violation of the reset recovery time. 

 Reset removal happening in different clock cycles for different sequential 

elements. 

Synchronization helps reduce such possible problems in the design. We can 

achieve synchronization by various means. A simple approach is to pass the reset 

through a metastability structure. 
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20. Let us assume that the reset synchronization is coming from a reset synchronizer 

block which is NOT part of this design. If this is the case, then you will see the 

messages reported for all occurrences where a reset is NOT asynchronously 

asserted and the synchronously de-asserted. There messages could be 

considered as NOISE. One way to prevent SpyGlass from reporting these 

messages is to apply an input constraint on the reset port and associate it to a 

clock. 

 

21. Double-clock the message for flip-flop “processor1.tmp_data[0]” in the 

“Reset_sync01” rule folder for “top.rst” and invoke the “Incremental Sch”. 
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22. The message report that the reset signal is NOT being synchronously de-asserted 

relative to clock signal “clk1”. 
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23. Let us apply an input constraint on the “rst” pin. At “Atrenta Console” window, 

expand the “Module View” by click “>>” 
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24. Switch Show type to “Constraints View”. 

 

 

 

25. Double-clock the constrains (SGDC) file from console UI 

SGDC file name processor1.sgdc 
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26. Edit the “processor1.sgdc” constraint file by pressing the hotkey <e>. This will 

open the file in the editor window. Uncomment the line with input declared. 
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27. Rerun the selected gaol 

 

 

28. No further “Reset_sync01” messages are being reported for “rst” with respect to 

“clk1”. 

 

 

[Think about it] 

If an input is registered in more than one clock domain, it will definitely be 

asynchronous with at least one of the clocks. Therefore, a synchronizer is 

required on at least on flop. The “Clock_sync05” rule is designed to flag these 

situations. Now, can you tell why primary input signal "in2" reported as 

"Clock_sync05" warning? 

(HINT: Use the Msg Tree tab and Incremental schematic.) 
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Lab 8 CDC functional verification 

 

1. Change directory to lab 8 

Unix% cd ~/ADPLL_LAB_2012_Winter/LAB/Lab_8 

 

2. Open the SpyGlass in interactive mode 

Unix% spyglass 

 
 

3. Open project 

Project file name Lab8.prj 
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4. Once you’ve cleaned up all the metastability issues, you are now ready to 

perform advance CDC checks on the design, such as Reset verification, 

FIFO/Handshake verification, etc. Click the drop down selection to load results of 

“cdc_verif” goal. 

 

 

 [Think about it] 

In addition to performing structural checks SpyGlass CDC will perform some 

functional checks using formal engines to verify the design functionality. 

Even if your synchronization schemes are in place, how sure can you be that they 

are functioning as expected? For example you have implemented a FIFO 

synchronizing scheme, how can you be sure that FIFO does not under-run or 

overflow? You have implemented some control logic which makes use of a gray 

code counter. How sure can you be that the behavior is as expected? 

 

[Tips] 

Make sure you do NOT have any “Ac_sanity04” messages. If there is any 

“Ac_sanity04”, none of the rest of the “Ac_” rules would be run due to this 

“Ac_sanity04” 

 

5. Data coherency (Convergence) – Gray code checks 

 

In the “Msg tree” tab of the message window, expand the “verif/cdc_verif” goal 

folder and then expand the “Ac_conv02” rule folder. 
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Double-click the reported violation message and use hotkey <i> to open 

incremental schematic window. 

 

 

When the synchronized signals converge, they typically, but NOT always, originate 

from some type of gray code counter. Once determining the re-converging 

synchronized signals, advance CDC checks can perform a gray code check on the 

signals. 
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With the message highlighted within “Ac_conv02” rule folder, use hotkey <w> to 

open the “SpyGlass Waveform Viewer”. 

 

 

From the waveform, it can be seen that signals feeding destination of 2 crossings 

“process1.gray.I1.temp” and “processor1.gray.I2.temp” are changing at the same 

time. Hence, this is a violation of gray code. 

 

 

[Think about it] 

Why the SpyGlass report re-converging singals do not follow gray encoding? 
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6. Close all windows expect the “Atreanta Console” window. 

 

7. Complex synchronizations schemes: FIFO under-run and overflow checks. 

 

In the “Msg tree” tab of the message window, expend the “verif/cdc_verif” goal 

folder and then expand the “Ac_fifo01” rule folder. 

 
 

Double-clock the message with memory “processor1.tx_fifo.mem” specifically 

the one with overflow. The message informs us that the read and write pointers 

have been identified for this FIFO implementation. 
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Invoke incremental schematic by pressing hotkey <i> to see identified FIFO 

structure. 

 

 

Advanced CDC checks can go one step further and identify whether the FIFO 

under-runs or overflows. The selected message reports that an overflow 

conditions has occurred. To view the failure, open the waveform, it can be 

inferred that the write pointer has been re-written into the address location 0. 

Now, at “Msg Tree” tab press hotkey <w> to open “SpyGlass Waveform Viewer”. 
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Right-click on “processor1.tx_fifo.wp[1:0]” and select “fanin”. 

 

 

 

  



[LAB 8 (SKIP) CDC FUNCTIONAL VERIFICATION] 2012年 3月 16日 

 

Using PLL in Cell-Based Design / NARL CIC DSD DTS C. L. Huang Lab 8 - 8 
 

Click to select “we_i” signals and press “OK”. 

 
 

It is apparent that write enable (we_i) is active even the FIFO is full. 

 

 

8. Close all windows expect the “Atreanta Console” window. 
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9. Complex synchronizations schemes: FIFO underflow checks 

 

Double-click the message reported by the “Ac_fifo01” rule about the FIFO with 

memory “processor1.tx_fifo.mem”. The message reports that an underflow 

condition has occurred. 

 

 

Open the waveform for this message. 

 

 

Trace the “processor1.tx_fifo.rp[1:0]” read pointer signal. 
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[Think about it] 

What wrong with the “processor1.tx_fifo.rp[1:0]” read pointer signal? 

 

10. Close all windows expect the “Atreanta Console” window. 

 

11. Handshake synchronizations schemes: data loss in handshake and four phase 

handshake protocol check. 

 

In the message tree of the tab of the message window, expand the “verif” goal 

folder then expand the “Ac_handshake02” rule folder. 

 
 

Double click the message. This message informs that the request and 

acknowledgement signals have been identified for handshake synchronization 

structure. Advanced CDC checks whether the handshake synchronization follows 

four phase handshake protocol. Spyglass identifies the “REQ-ACK” loop of 

handshake structure. To view the “REQ-ACK” loop. Highlight the message by 

double clicking the message and then open incremental sch. 
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To view the failures open the waveform viewer. From the waveform viewer it can 

be seen that four phase protocol is not followed. The “busreq” signal goes 

inactive and then comes active again before the “core_ack_1” (acknowledgement) 

goes inactive. 
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